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1. About this Manual 
This manual provides the required information that Balance Sheet Planning 
Application administrator needs to setup the application. The document 
contains steps to create Hyperion Planning Application with BSP specific 
parameters, Creating Essbase Database, steps for creating Balance Sheet 
Planning relational data model and other required configurations. 

2. Audience 
This Manual is meant for use by the Oracle Financial Services Analytical 
Applications Infrastructure System Administrator or Hyperion System 
Administrator. It provides step-by-step instructions necessary for configuring 
the Oracle Financial Services Balance Sheet Planning v6.1 Product.  

3. Environmental variables configuration 
Note: BSP is not certified to use on RHEL 6.x versions. 

Set the following environmental variables in the profile for the UNIX user 
where Hyperion Planning has been installed, if not already set: 

 
• EPM_ORACLE_HOME 
• MIDDLEWARE_HOME 
• HYPERION_HOME – Same as EPM_ORACLE_HOME 
• ORACLE_HOME - Oracle Client Home 
• JAVA_HOME 
• ARBORPATH=$EPM_ORACLE_HOME/products/Essbase/EssbaseServer 
• ESSBASEPATH=$EPM_ORACLE_HOME/products/Essbase/EssbaseServer 
• NLSPATH=$EPM_ORACLE_HOME/products/Planning/bin/nls/msg/en_US/ofs

msg.cat:$EPM_ORACLE_HOME/products/Planning/bin/nls/msg/C/ofsmsg.ca
t 

• INIPATH=$EPM_ORACLE_HOME/products/Planning/config 
• FIC_HOME=$EPM_ORACLE_HOME 
• FIC_DB_HOME=$EPM_ORACLE_HOME/logs/bsplog 
• PATH=$JAVA_HOME/bin:$ARBORPATH/bin:$EPM_ORACLE_HOME/products/P

lanning/bin:$EPM_ORACLE_HOME/products/Planning/config:$EPM_ORACLE_
HOME/products/Planning/lib:$ORACLE_HOME/bin:$PATH:$HOME/bin 

• LD_LIBRARY_PATH=$ORACLE_HOME/lib:$ORACLE_HOME/rdbms/public:$EPM_ORA
CLE_HOME/common/ODBC-
64/Merant/7.0/lib:$EPM_ORACLE_HOME/products/Planning/lib:$ARBORPATH/bin 

• LD_LIBRARY_PATH_64=$LD_LIBRARY_PATH:$LD_LIBRARY_PATH_64 
• ODBCINI=$EPM_ORACLE_HOME/common/ODBC-64/Merant/7.0/odbc.ini 
• ODBCINST=$EPM_ORACLE_HOME/common/ODBC-

64/Merant/7.0/odbcinst.ini 

Note: You need to make the changes into the .profile file of the UNIX account 
where Planning and ESSBASE are installed. Oracle client is required on the 
servers where Hyperion ESSBASE and Planning are installed. BSP uses the Oracle 
drivers. 
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4. Installation of BSP 6.1 on Hyperion Planning PS3  
Hyperion PS3 bundles BSP 6.1 files. Installing Hyperion will only deploy the 
BSP files. BSP needs to be subsequently “initialized” in order to access it. 

If CAPEX and/or WORKFORCE applications are required, initialize CAPEX and/or 
WORKFORCE after BSP initialization is complete.  

Note: For PS3, sequence of initialization to be BSP, CAPEX, and then 
WORKFORCE. 

Furthermore, after initializing the WORKFORCE and/or CAPEX modules you 
need to perform the following activities. 

o Go to Manage->Dimension->Account and Entity Dimensions 

o Edit “No Entity” and “No Account” members and select the option 

“BSP”, “Rates” and “Core” Plan types. Perform a database refresh. 

4.1 Hyperion Planning Application Creation 

Note: Setup Classic Planning Application for Balance Sheet Planning as 
described in Oracle Hyperion Planning, Fusion Edition Administrator’s 
Guide. 
 
Select the value of following options in Create Application Wizard as 
specified below: 

 

Application Type: Generic 

First Fiscal Year -> Start Year: Set the value as per below illustration  

If start year falls in a century between: 

1900-2000 – Then start year will be 1980 

2000-2100 – Then start year will be 2000  

2100-2200 – Then start year will be 2100 and so on. 

Note: Here, Start year should be any centennial year such as, 2000, 
2100, and so on. BSP recommends to use 2000 as the Start year. 

Create 5 Plan Types as given below: 

Plan Type 1: BSP 
Plan Type 2: Rates 
Plan Type 3: Core 
Plan Type 4: WORKFORCE [WRKFORCE] 
Plan Type 5: CAPEX 

NOTE: You must create all five Plan Types even if you are not planning to 
use Workforce and/or CapEx in your implementation. 

 
Change the Date format in File -> PreferencesDisplay Options to MM-DD-YYYY  
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Note: While creating the Hyperion Planning Application, you can use any 
Application Name. BSP does not place any restriction on the Application 
naming conversion. It is recommended to not use any special characters, 
like &, *, ‘’, ””, %, and so on. 

4.2 Create Essbase Database 

• Log in to Balance Sheet Planning Application using the administrator 
username and password  

• Go to Administration->Application->Create Database screen and 
selection options specified in the screen and create database. 

 

4.3 Create Balance Sheet Planning Relational Data Model 

• Create a tablespace with the user define name. The same table space 
name should be used in user “Configuration” UI for the variable 

TABLESPACE. TABLESPACE  

Note: Here, this tablespace refers to Oracle TABLESPACE and all the 
output tables of Cash Flow Engine will be created in this TABLESPACE. 

• Create Oracle database user for Balance Sheet Planning Relational 
Data Model in the tablespace as created in previous step. This 
database user should have ‘create’ privileges on tablespace it belongs 
to 
o This database user is different than Hyperion configuration 

database users and application data source. 
Note: BSP requires a distinct schema that is different from the schema 
created for creation of an application in Hyperion Planning (which is 
created in section 4.1 Hyperion Planning Application Creation). 

o Assign the following specific privileges to the user created for 
Balance Sheet Planning. These privileges are 
 

GRANT MGMT_USER TO <DBUSERNAME>;  
GRANT SELECT_CATALOG_ROLE TO <DBUSERNAME>;  
GRANT CREATE PROCEDURE TO <DBUSERNAME>;  
GRANT CREATE SEQUENCE TO <DBUSERNAME>;  
GRANT CREATE SESSION TO <DBUSERNAME>;  
GRANT CREATE SYNONYM TO <DBUSERNAME>;  
GRANT CREATE TABLE TO <DBUSERNAME>;  
GRANT CREATE TRIGGER TO <DBUSERNAME>;  
GRANT CREATE TYPE TO <DBUSERNAME>;  
GRANT CREATE VIEW TO <DBUSERNAME>; 

4.4 Create Data Source DSN to Database 

Note: BSP requires only one Data Source, this data-source will point to 
the Oracle schema where the BSP application will be initialized. 

• Open $HYPERION_HOME/common/ODBC-64/Merant/7.0/odbc.ini.  
• Add a new ODBC Data Source entry pointing to the Oracle-schema into 

which BSP was initialized, in section 4.3 Create Balance Sheet Planning 
Relational Model. This name should later be specified in the BSP’s 
configuration UI (available in Planning under Administrator Activities -
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> Master Maintenance -> Assumption Forms -> Configuration), as 
mentioned in Section 5 below. 

• The entry should contain information required to connect to the 
schema created for BSP objects.  

• Verify Host Name, Logon ID, Password, Port Number, and SID contain 
the information required to connect to the schema. 

5. Initializing Balance Sheet Planning  
• Login into Hyperion Planning 
• Go to AdministrationApplication-->Properties 
• In the Properties window Add new row  

o Properly Name = APPTYPE Property Value = BSP 
o Restart the Planning Sever 

• Go to AdministrationInitialization->Balance Sheet Planning. 
• Specify the below parameters: 

• Server: Database Server Name/IP Address  
• Port: Database port 
• Database: Database SID 
• User: Username 
• Password: Password for Database schema 
• APS Server: <IPAdress> 

Below is a sample screenshot: 

 

The Model option (in above sample screenshot) allows you to choose the 
number of custom dimensions that you need for initialization of BSP. This 
drop-down list has following options:  

• Standard – No additional custom dimensions 
• Custom 1 - One additional custom dimension 
• Custom 2 - Two additional custom dimensions 

Note: The following errors generated to the bsplog.log during Initialize BSP 
step may be ignored:  

• Error:ORA-00001: unique constraint (PLANBSP.PK_FSI_M_LOOKUP_B) 
violated.  

• Error:ORA-00001: unique constraint 
(PLANBSP.PK_FSI_M_LOOKUP_MASTER) violated. 

• Error:ORA-00001: unique constraint 
(PLANBSP.PK_FSI_M_LOOKUP_TL) violated.  

• Error:ORA-00955: name is already used by an existing object.  
Error:ORA-01418: specified index does not exist. 

• Error:ORA-01430: column being added already exists in table. 
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• Error:ORA-02260: table can have only one primary key.  
• Error:ORA-00911: invalid character 
• Error:ORA-12899: value too large for column.  

"PLANBSP"."FSI_APPLICATIONS"."VERSION" (actual: 11, maximum: 
10)  

• Error:ORA-00942: table or view does not exist for table  
“FSI_DIM_ACCOUNT_SETUP_DETAILS”. 

Note: In case you are planning for an integrated installation of BSP with 
OFSAA applications, you should first initialize BSP as a standalone installation 
and then point BSP to the OFSAA instance.  

• Select “Finish” 
• After successful initialization, click the “Configure” button to launch the 

“Configuration UI”.  

Note: The config.xml file gets updated automatically as the part of 
configuration process.  

• Specify values for the parameters as mentioned under “annexure” 
section and click “save”. 

• Edit the file 
$EPM_ORACLE_HOME/products/Planning/bin/bsp_user_profile.sh file to 
specify the path for ORACLE_HOME variable. 

5.1 Set Evaluation Order 

Go to Administration->Dimensions->Evaluation Order tab. 

o For BSP Plan type: 
 Set Chart of Account, Attribute Value and then Account 

Dimension. 
o For Rates Plan type:      

 Set Rate Element then Mix Breakout Dimension 

5.2 Steps to Enable Validation Rules 

Follow the below steps to enable the validation rules: 

1) Go to Manage data form open the Loan Fees form and click on column 

A the Loan_Fees_VR Validation rule is enable open this rule and select 

the Chart of Account dimension against attribute of source type in last 

condition. Then click ok and save the form. 

2) Go to Manage data form open the Loan Fees Annual form and click on 

Grid the Loan_Fees_VR, Loan_Fees_VR1, Validation rules are enable 

open these rules and select the Chart of Account dimension against 

attribute of source type in last condition. Then click ok and save the 

form. 

3) Go to Manage data form open the Deposit Service Charge form and 

click on Grid the Dep_Svc_Chg_VR, Validation rules are enable open 

this rule and select the Chart of Account dimension against attribute of 

source type in last condition. Then click ok and save the form. 

4) Go to Manage data form open the Deposit Service Charge Annual form 

and click on Grid the Dpst_Svc_Chg_Annl_VR, Loan_Fees_VR1, 
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Validation rules are enable open these rules and select the Chart of 

Account dimension against attribute of source type in last condition. 

Then click ok and save the form. 

5) Go to Manage data form open the Synchronization for Balance 

Accounts form and click on Row1 the Syn_Assets_VR, Syn_Liabty_VR, 

Validation rules are enable open these rules and select the Chart of 

Account dimension against attribute of source type in last condition. 

Then click ok and save the form 
    

5.3 LCM export and Preparation for Metadata Synchronization. 

1) Post the Loading of Metadata in to BSP Planning Application, the 

administrator should export the Application Metadata to File System in 

Shared Services. 

2) Administrator has to login into Shared Services and Select the BSP 

Planning Application. 

3) In the Artifact Summary Page at the right Bottom Submit Select All 

and then Click Export. 

4) Here the Administrator defines a LCM Directory Name which has to be 

provided in Configuration Custom UI in the BSP Application 

5) Once the LCM export is completed, a .zip file will be created with the 
given name in shared services.  

6) This .zip file will be located in the import_export path of the Hyperion 
Instance chosen during Installation.  

5.4 Metadata Synchronization 

1) After completing the Preparation for Metadata Sync, Login to the BSP 

application, Select Administrator Activities folder in the left pane. 

2) Select Master Maintenance form and then Right Click on the menu 

appeared as large square box. 

3) From the right click menu Select Metadata Synchronization and choose 

the type needed by the Administrator Purpose. 
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6. Create an Integrated set up for Hyperion/BSP and OFSAAI  
6.1   Pre-requisites 

1) Execute the below SQL on the configuration-schema – replace 

$ATOMIC_USER with the name of the information-domain schema 

user. 

Grant select on SETUPINFO to $ATOMIC_USER; 

2) On OFSAAI, applications have been installed and configured.  

3) BSP OPatch 13879279 has been applied and BSP has been successfully 

initialized on Hyperion 11.1.2.3.0 PS3 release.  Note down the 

initialization mode, that is standard or custom1 or custom2. 

Note: OFSAA Atomic Schema and BSP Schema (schema in which BSP was 
initialized) should be on the same Database.  

6.2  Steps to integrate BSP with OFSAAI 

1) Download the Patch 17486220 and apply it as per the steps described 
in the Readme file. 

2) Take the BSP ERWIN Model (BSP_Datamodel.erwin) and perform 
the following customizations in ERWIN, as applicable 
a. Merge this model with the ERWIN model of other applications 

installed on OFSAAI 
b. If CUSTOM1 option was selected in Pre-requisite step #3, modify to 

merged model to add a column called CUSTOM1 in the following 
super-type objects 

i. BSP_LEAF_COLUMNS 
ii. LEDGER_LEAF_COLUMNS 

Note: While adding the column, set the UDPs to the same 
values as that of the STRATEGY_ID column 

c. If CUSTOM2 option was selected in Pre-requisite step #3, modify to 
merged model to add two columns called CUSTOM1 and CUSTOM2 
in the following super-type objects 

i. BSP_LEAF_COLUMNS 
ii. LEDGER_LEAF_COLUMNS 

Note: While adding the columns, set the UDPs to the same 
values as that of the STRATEGY_ID column 

d. Perform an incremental model-upload of this model in OFSAAI, into 
the required information domain. 

3) Execute one of the below mentioned sql script as per opted data model 
type in Pre-requisite step #3. 
a. execbspdm_std_integrate_to_ofsaai_6_1.sql - if BSP initialization is 

STANDARD 
b. execbspdm_custom1_integrate_to_ofsaai_6_1.sql - if BSP 

initialization is CUSTOM 1 
c. execbspdm_custom2_integrate_to_ofsaai_6_1.sql - if BSP 

initialization is CUSTOM 2 
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Note: These scripts will prompt you for the configuration schema 
name. Specify the name of the configuration-schema followed by a 
“dot”; for example: CONFIGUSER. 

4) Login to Planning, launch the BSP Configuration UI and change the 
database username/password/Tablespace values to that of the 
OFSAA’s atomic schema. Click Save and confirm that the settings have 
been saved successfully. 

5) In OFSAA, create a new segment called BSP and map this segment to 
the required OFSAA users. This folder will be the container for sharing 
rules/assumptions between ALM/FTP and BSP. 

6) If the default-product dimension in OFSAA is PRODUCT_ID, execute 
the script bsp_preference_product_id.sql on the atomic schema. 

7) The sliced model upload of BSP will introduce one or more additional 
leaf dimensions into the data model. To reflect these additional 
dimensions in the respective applications, perform the following steps 
a. For OFS ALM: On the OFSAA Atomic schema, drop all tables with 

the name RES_DTL_XXXXX / CONS_DTL_XXXX – re-execute the 
relevant ALM Processes to regenerate the tables. 

b. For OFS PFT: In the OFSAA Information Domain, open and resave 
all the OFS-PFT allocation rules so that the new leaf-dimensions are 
referenced properly 

8) Execute the post.sh under 
$EPM_ORACLE_HOME/Opatch/13879279/custom/scripts. 
Ensure that the $EPM_ORACLE_HOME is properly set before executing 
the script. 

9) Edit $EPM_ORACLE_HOME/products/Planning/bin/bsp_user_profile.sh 
to specify the correct path for ORACLE_HOME.  

10) Modify the entry made earlier in odbc.ini & point it to the OFSAA 
Atomic Schema. The odbc.ini file is usually found under 
$EPM_ORACLE_HOME/common/ODBC-64/Merant/7.0/ folder. 

6.3  Limitations 

1) The Time Buckets cannot be shared across OFSAAI and BSP 
applications. The user has to create the required Time buckets to be 
used for BSP through BSP UI and the user should not EDIT / modify 
these newly defined time buckets through OFSAAI UI. 

2) The defined Forecast rates cannot be shared across in ALM and BSP, 
because of hybrid nature of forecast rates sys id generated in BSP. 

3) The currencies created through BSP UI cannot be edited through 
OFSAAI UIs and vice versa. 

4) BSP does not support Breakage Charges as adjustment type. 
The Adjustment Rule definitions created through OFSAAI Uis, having 
Adjustment Method as Formula Based Rate and Assignment date as 
Origination Date only will be viewable / editable in BSP. 
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7. Distributed Environment Setup 
Perform the below steps when Hyperion Planning is installed in a distributed 
manner, that is, the Hyperion components Planning and ESSBASE are installed 
on separate servers. 

Note:  

- Hyperion ESSBASE should not be installed on Windows 
- Hyperion ESSBASE and Hyperion Shared Services must be installed on 

the same UNIX Server 
- The OS/Version of the server where Planning is installed must be the 

same as the OS/Version of the server where ESSBASE is installed. 
- Steps mentioned below should be repeated after every  

I. Initialization/re-initialization of Hyperion Planning generic 
application(s) created for Balance Sheet Planning using 
“AdministrationInitializationBalance Sheet Planning”.  

II. Update of Configuration settings for Balance Sheet Planning using 
“Master MaintenanceAssumption FormsConfiguration”. 

Perform the following steps, in the given sequence 

1. Ensure that tnsnames.ora on the ESSBASE Server is configured with the 
same name as on the Planning server, to connect to the database 
specified during initialization of BSP.  

2. Copy the $EPM_ORACLE_HOME/common/ODBC-64/Merant/7.0/odbc.ini 
from the Planning server to the corresponding folder on ESSBASE 
Server, and update the odbc.ini for driver path for the BSP-specific 
entry. 

3. Save the Configuration Parameters in Planning; while saving the 
configuration, make sure that LCMDIRPATH is the LCM export path as on 
the ESSBASE server. 

4. From the annexure, copy “BSP_RunOnPlanning.sh” and 
“BSP_RunOnEssbase.sh” to $EPM_ORACLE_HOME/products/Planning/bin  
on the Planning Server 

5. Give execute permissions to “BSP_RunOnPlanning.sh” and run the script 
without passing any parameters. The script will create a gzip archive 
“bsp.tar.gz” in the same folder.  

6. Copy “BSP_RunOnEssbase.sh” and “bsp.tar.gz” from 
$EPM_ORACLE_HOME/products/Planning/bin to $EPM_ORACLE_HOME in 
ESSBASE Server, to where ESSBASE is installed. 

7. Give execute permissions to “BSP_RunOnEssbase.sh” and run the script 
without passing any parameters. 

8. On the ESSBASE server, modify bsp_user_profile.sh present under 
$EPM_ORACLE_HOME/products/planning/bin, and set the 
ORACLE_HOME as appropriate. 

 

                     


## Log File

export LOG_FILE="bsp_runonessbase.log"



## Log file cleanup

if [ -f $LOG_FILE ]

then

rm $LOG_FILE

fi



## Create Log file

touch $LOG_FILE



## Color codes

RED_F=$'\033[31m'

GREEN_F=$'\033[32m'

WHITE_F=$'\033[37m'

YELLOW_B=$'\033[43m'

BLUE_F=$'\033[34m' 

NORM=$'\033[0m'

ERR="ERROR : "

WARN="WARN  : "

INFO="INFO  : "



alert()

{

MESSAGE=$1

MODE=$2

BANNER_ERROR=${RED_F}${ERR}${MESSAGE}${NORM}

BANNER_WARN=${YELLOW_B}${BLUE_F}${WARN}${MESSAGE}${NORM}

BANNER_INFO=${GREEN_F}${INFO}${MESSAGE}${NORM}

BANNER_DEF=${NORM}${MESSAGE}



if [ "x${MODE}" = "x" ]; then

	echo $BANNER_DEF | tee -a $LOG_FILE

elif [ "x${MODE}" = "x1" ]; then

	echo $BANNER_INFO | tee -a $LOG_FILE

elif [ "x${MODE}" = "x2" ]; then

	echo $BANNER_WARN | tee -a $LOG_FILE

elif [ "x${MODE}" = "x3" ]; then

	echo $BANNER_ERROR | tee -a $LOG_FILE

fi



}



export srcdir=`pwd`

export STORE=$srcdir

export BSP_TAR=$STORE/bsp.tar.gz

alert "Tar File : $BSP_TAR" 1

#

# check for JAVA existence and version required

#

export WHICH_JAVA=`which java`

JAVA_MIN_REQUIRED_VERSION=1.6

JAVA_REQUIRED_VERSION=`echo $JAVA_MIN_REQUIRED_VERSION | sed -e 's;\.;0;g'`

alert "Required Java Version: $JAVA_MIN_REQUIRED_VERSION" 1

JAVA_CHECK=0

FILE_SIZE=0



find_java()

{

if [ "x${JAVA_HOME}" = "x" ]; then

alert "Environment variable JAVA_HOME is not set." 3

else

alert "Java Home: $JAVA_HOME" 1

export JAVA_EXE=$JAVA_HOME/bin/java

fi	

}



find_version()

{

alert "Java executable: $JAVA_EXE" 1



$JAVA_EXE -version 2>tmp.ver



export VERSION=`cat tmp.ver | grep "java version" | awk '{ print substr($3, 2, length($3)-2); }'`

alert "Java Version found: $VERSION" 1

VERSION=`echo $VERSION | awk '{ print substr($1, 1, 3); }' | sed -e 's;\.;0;g'`



rm tmp.ver

if [ $VERSION ]

then

	if [ $VERSION -ge $JAVA_REQUIRED_VERSION ]

	then

		JAVA_CHECK=1

	fi

fi

}



if [ $WHICH_JAVA ]

then

	export JAVA_EXE=$WHICH_JAVA

	find_version

	if [ "x$JAVA_CHECK" = "x0" ]; then

	alert "Look up JAVA_HOME for required version" 1

	find_java

	find_version

	fi

else

	find_java

	find_version

fi	







#

# check for EPM_ORACLE_HOME

#

if [ "x${EPM_ORACLE_HOME}" = "x" ]; then

alert "Environment variable EPM_ORACLE_HOME is not set. Exiting." 3

else

	alert "EPM_ORACLE_HOME : ${EPM_ORACLE_HOME}" 1

	export EPM_ORACLE_INSTANCE=$EPM_ORACLE_HOME/../user_projects/epmsystem1

	if [ ! -d "$EPM_ORACLE_INSTANCE/Planning/planning1" ]

	then

		mkdir -p $EPM_ORACLE_INSTANCE/Planning/planning1

	fi

	if [ -f $BSP_TAR ]

	then

		alert "### Extracting files  ###" 1

		tar -xvf $BSP_TAR | tee -a $LOG_FILE

		mv -f $EPM_ORACLE_HOME/products/Planning/config/config.xml  $EPM_ORACLE_INSTANCE/Planning/planning1/

		if [ -f $EPM_ORACLE_INSTANCE/Planning/planning1/config.xml ]

		then

			if [ "x$JAVA_CHECK" = "x1" ]; then

			$JAVA_EXE -cp $EPM_ORACLE_HOME/products/Planning/lib/bspudf.jar:$EPM_ORACLE_HOME/products/Planning/lib/ess_japi.jar:$EPM_ORACLE_HOME/products/Planning/lib/log4j-1.2.14.jar:$EPM_ORACLE_HOME/products/Planning/lib/xmlparserv2.jar com.oracle.bsp.configuration.ClsConfigurationFactory reverse | tee -a $LOG_FILE

			alert "Refer log files under $EPM_ORACLE_HOME/logs/bsplog" 1

			else

			alert "Java $JAVA_MIN_REQUIRED_VERSION required. $EPM_ORACLE_HOME/products/Planning/config/config.xml not processed" 3

			fi

		fi

		

		if [ -d ${EPM_ORACLE_HOME}/products/Planning/bin ] 

		then

			cd ${EPM_ORACLE_HOME}/products/Planning/bin



			if [ -f bsp_user_profile.sh ]

			then

				chmod 755 bsp_user_profile.sh

			fi



			if [ -f bspbc.sh ]

			then

				chmod 755 bspbc.sh

			fi



			if [ -f ofsrm.sh ]

			then

				chmod 755 ofsrm.sh

			fi



			if [ -f ofsbc ]

			then

				chmod 755 ofsbc

			fi



			if [ -f ofsrm ]

			then

				chmod 755 ofsrm

			fi

		else

			alert "${EPM_ORACLE_HOME}/products/Planning/bin folder not extracted" 3

			alert "Please check $BSP_TAR exist and contain the required folders as mentioned in distributed environment install guide" 3

		fi

	else

		alert "bsp.tar.gz not found. Extraction cannot continue" 3

	fi

	alert "Log file : $srcdir/$LOG_FILE" 1

fi









adanayak
File Attachment
BSP_RunOnEssbase.sh


## Log File

export LOG_FILE="bsp_runonPlanning.log"



## Log file cleanup

if [ -f $LOG_FILE ]

then

rm $LOG_FILE

fi



## Create Log file

touch $LOG_FILE



archive_file()

{	if [ -f "$1" ]; then

		if [ -f "$BSP_TAR" ]

		then

			tar uvf $BSP_TAR $1 | tee -a $LOG_FILE > /dev/null 

		else

			tar cvf $BSP_TAR $1 | tee -a $LOG_FILE > /dev/null

			

		fi

		

		

	fi

}



## Color codes

RED_F=$'\033[31m'

GREEN_F=$'\033[32m'

WHITE_F=$'\033[37m'

YELLOW_B=$'\033[43m'

BLUE_F=$'\033[34m' 

NORM=$'\033[0m'

ERR="ERROR : "

WARN="WARN  : "

INFO="INFO  : "



alert()

{

MESSAGE=$1

MODE=$2

BANNER_ERROR=${RED_F}${ERR}${MESSAGE}${NORM}

BANNER_WARN=${YELLOW_B}${BLUE_F}${WARN}${MESSAGE}${NORM}

BANNER_INFO=${GREEN_F}${INFO}${MESSAGE}${NORM}

BANNER_DEF=${NORM}${MESSAGE}



if [ "x${MODE}" = "x" ]; then

	echo $BANNER_DEF | tee -a $LOG_FILE

elif [ "x${MODE}" = "x1" ]; then

	echo $BANNER_INFO | tee -a $LOG_FILE

elif [ "x${MODE}" = "x2" ]; then

	echo $BANNER_WARN | tee -a $LOG_FILE

elif [ "x${MODE}" = "x3" ]; then

	echo $BANNER_ERROR | tee -a $LOG_FILE

fi



}



## Initialization

export srcdir=`pwd`

export STORE=$srcdir

export BSP_TAR=$STORE/bsp.tar.gz



export PLANNING=products/Planning

export PLANNING_LIB=$PLANNING/lib

export PLANNING_LIB64=$PLANNING/lib64

export PLANNING_BIN=$PLANNING/bin

export PLANNING_CFG=$PLANNING/config

export PLANNING_INSTANCE_CFG=$EPM_ORACLE_HOME/../user_projects/epmsystem1/Planning/planning1

export EPM_ORACLE_INSTANCE=$EPM_ORACLE_HOME/../user_projects/epmsystem1





export ESSBASE=products/Essbase/EssbaseServer

export ESSBASE_BIN=$ESSBASE/bin



##Create temp-store

if [ -f "$STORE/bsp.tar.gz" ]

then

rm $STORE/bsp.tar.gz

fi





alert "Current folder : $srcdir" 1





cd $EPM_ORACLE_HOME



#

# check for JAVA existence and version required

#

export WHICH_JAVA=`which java`

JAVA_MIN_REQUIRED_VERSION=1.6

JAVA_REQUIRED_VERSION=`echo $JAVA_MIN_REQUIRED_VERSION | sed -e 's;\.;0;g'`

alert "Required Java Version: $JAVA_MIN_REQUIRED_VERSION" 1



JAVA_CHECK=0

FILE_SIZE=0



find_java()

{

if [ "x${JAVA_HOME}" = "x" ]; then

alert "Environment variable JAVA_HOME is not set." 3	

else

alert "Java Home: $JAVA_HOME"

export JAVA_EXE=$JAVA_HOME/bin/java

fi	

}



find_version()

{

alert "Java executable: $JAVA_EXE"

$JAVA_EXE -version 2>tmp.ver



export VERSION=`cat tmp.ver | grep "java version" | awk '{ print substr($3, 2, length($3)-2); }'`

alert "Java Version found: $VERSION"

VERSION=`echo $VERSION | awk '{ print substr($1, 1, 3); }' | sed -e 's;\.;0;g'`



rm tmp.ver

if [ $VERSION ]

then

	if [ $VERSION -ge $JAVA_REQUIRED_VERSION ]

	then

		JAVA_CHECK=1

	fi

fi

}



if [ $WHICH_JAVA ]

then

	export JAVA_EXE=$WHICH_JAVA

	find_version

	if [ "x$JAVA_CHECK" = "x0" ]; then

	alert "Look up JAVA_HOME for required version" 2

	find_java

	find_version

	fi

else

	find_java

	find_version

fi	





########################

### Backup bin files ###

########################

alert "Archiving 'bin' files" 1

if [ -f products/Essbase/EssbaseServer/bin/libcpptripledes.so ]

then

cp $PLANNING_LIB/libcpptripledes.so $ESSBASE_BIN

archive_file $ESSBASE_BIN/libcpptripledes.so

fi



archive_file $PLANNING_BIN/bspbc.sh

archive_file $PLANNING_BIN/bsp_user_profile.sh

archive_file $PLANNING_BIN/ofsbc

archive_file $PLANNING_BIN/ofsrm

archive_file $PLANNING_BIN/ofsrm.sh

archive_file $PLANNING_BIN/nls/msg/C/ofsmsg.cat

archive_file $PLANNING_BIN/nls/msg/en_US/ofsmsg.cat







###########################

### Backup config files ###

###########################

alert "Archiving 'config' files" 1

archive_file $PLANNING_CFG/*.ini

archive_file $PLANNING_CFG/strip-space.xsl



#Backup config xml for migration

if [ -f $PLANNING_INSTANCE_CFG/config.xml ]

then

cp $PLANNING_INSTANCE_CFG/config.xml $PLANNING_INSTANCE_CFG/config_org.xml

if [ "x$JAVA_CHECK" = "x1" ]; then

$JAVA_EXE -cp $PLANNING_LIB/bspudf.jar:$PLANNING_LIB/ess_japi.jar:$PLANNING_LIB/log4j-1.2.14.jar:$PLANNING_LIB/xmlparserv2.jar com.oracle.bsp.configuration.ClsConfigurationFactory mask | tee -a $LOG_FILE

else

alert "Java $JAVA_MIN_REQUIRED_VERSION required. $EPM_ORACLE_HOME/../user_projects/epmsystem1/Planning/planning1/config.xml not processed." 3

fi

cp $PLANNING_INSTANCE_CFG/config.xml $PLANNING_CFG/config.xml

archive_file $PLANNING_CFG/config.xml

rm $PLANNING_INSTANCE_CFG/config.xml

mv $PLANNING_INSTANCE_CFG/config_org.xml $PLANNING_INSTANCE_CFG/config.xml

fi



count=`ls -1 $PLANNING_INSTANCE_CFG/*.SEC 2>/dev/null | wc -l`



if [ $count != 0 ]

then 

for secfile in $PLANNING_INSTANCE_CFG/*.SEC

do

archive_file "${secfile}"

done

fi 



archive_file $PLANNING_CFG/ofsbc.ini

archive_file $PLANNING_CFG/ofsrm.ini



########################

### Backup lib files ###

########################

alert "Archiving 'lib' files" 1

archive_file $PLANNING_LIB64/libaccess.so

archive_file $PLANNING_LIB64/libcftm.so

if [ -f $PLANNING_LIB64/libcpptripledes.so ]

then

archive_file $PLANNING_LIB64/libcpptripledes.so

fi

archive_file $PLANNING_LIB64/libDatabase.so

archive_file $PLANNING_LIB64/libadcoadapter.so

archive_file $PLANNING_LIB64/libbcservices.so



archive_file $PLANNING_LIB64/libdbmem.so

archive_file $PLANNING_LIB64/libdbviews.so

archive_file $PLANNING_LIB64/libeng.so

archive_file $PLANNING_LIB64/libengdb.so

archive_file $PLANNING_LIB64/liberrlog.so

archive_file $PLANNING_LIB64/libexecf.so

archive_file $PLANNING_LIB64/libfcmain.so

archive_file $PLANNING_LIB64/libglbl.so

archive_file $PLANNING_LIB64/libI18N.so

archive_file $PLANNING_LIB64/libicc.so

archive_file $PLANNING_LIB64/libiccsock.so

archive_file $PLANNING_LIB64/libiomod.so

archive_file $PLANNING_LIB64/libmisc.so

archive_file $PLANNING_LIB64/liboci.so

archive_file $PLANNING_LIB64/libofsabase.so

archive_file $PLANNING_LIB64/libppay.so

archive_file $PLANNING_LIB64/librates.so

archive_file $PLANNING_LIB64/librevdtl.so

archive_file $PLANNING_LIB64/libSms.so

archive_file $PLANNING_LIB64/libte.so

archive_file $PLANNING_LIB64/libtls9015d.so

archive_file $PLANNING_LIB64/libtp.so

archive_file $PLANNING_LIB64/libtptm.so

archive_file $PLANNING_LIB64/libtscdbg.so

archive_file $PLANNING_LIB64/libtsctask.so

archive_file $PLANNING_LIB64/libunix.so

archive_file $PLANNING_LIB64/libutils.so

archive_file $PLANNING_LIB64/libvlib.so

archive_file $PLANNING_LIB64/libvparse.so



archive_file $PLANNING_LIB/bspudf.jar

archive_file $PLANNING_LIB/ess_japi.jar

archive_file $PLANNING_LIB/log4j-1.2.14.jar

archive_file $PLANNING_LIB/xmlparserv2.jar



alert "Archive Created. $BSP_TAR" 1

alert "Log file : $srcdir/$LOG_FILE" 1



adanayak
File Attachment
BSP_RunOnPlanning.sh
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8. Annexure  
 

List of Parameters 

Sl. No. Parameter Name Description 

1 PASSWORD  Database Password 

2 USERNAME  Database User 

3 DSNNAME 

DSNNAME
 

 DSN Name (value should be the system DSN 

name configured for ODBC) 

Note: You should use the same DSN name 

which is created using section 4.4. 

DSN Name
 

4 SERVERNAME 

SERVERNAME
 

 Essbase Server Name 

5 ESSUSER 
 Essbase User Name Essbase User Na

 

6 
ESSPWD ESSPWD

 
 Essbase Password 

7 LCMDIRPATH 

LCMDIRPATH
 

 LCM Directory path 

8 LCMDirName 

LCMDIRNAME
 

 LCM Directory Name  

Note: You can use underscore  

 ("_”) in LCM Directory Name, but hyphen ("-") 

is not allowed. LCM Directory Na
 

9 
FirstYr FirstYr

 
 First Year 

10 EndYr  End Year 

11 CurrMonth 

CurrMonth
 

 Current Month 

12 StartPeriod  Start Period (By Default set to Jan) 

13 EndPeriod 

EndPeriod

 End Period (By Default set to Dec)

End Period
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Sl. No. Parameter Name Description 

StartPeriod
 

14 TABLESPACE 
 DB Table Space Table Space  
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Setting of Substitution Variable 

Note: If you are attempting to open a Form in BSP and following error 
appears: "A substitution variable required for this calculation is undefined. 
Variable: SecondYr", then set the SecondYr variable in Essbase 
Administration Services. 

SecondYr is a substitution variable. Any other variable can also be appeared in 
the above error message. Follow the below steps to configure the variable: 

1. Log in to EAS Console: http://<hostname>:19000/easconsole 
2. Click on "Launch" 
3. The Essbase Administration Services console will open. 
4. Expand Enterprise View -> Essbase Servers. 
5. Right-click on your server -> Edit -> Variables. 
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6. The Substitution Variables window will open. Go to the variable you are 
looking for and double-click on the value 

7. Enter the value and click on Set. 

 
8. Go back to BSP, and reload the Form.  

Note: Logout and Login are not required. 
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